ABSTRACT

When first presented with SAS® Enterprise Guide®, many existing SAS® programmers do not know where to begin and want to understand “What’s in it for me?” if they switch over. These longtime users of SAS are accustomed to entering all their code into the Program Editor window and clicking Submit. This paper introduces SAS Enterprise Guide 6.1 to old and new users of SAS who need to code. It even points out advantages and tips that will demonstrate why a user would be excited about the switch. This paper focuses on the key points of a session involving coding and introduces new features. It also covers the top items for a user to consider when switching over to a server-based environment. Attendees will return to the office with a new motivation and confidence to start coding with SAS Enterprise Guide.

WELCOME - TRAVELING TO A NEW DESTINATION

For those of you who have been programming in SAS for at least a couple of years, you might be very comfortable with the traditional SAS Windowing Environment. You enter code into the Enhanced Editor on your PC and submit your program. Any notes or warnings are viewed in the Log window while results are viewed in the Output Window. When you work with SAS in this manner, you are running a 'local' version of SAS. In other words, SAS is installed on your local machine, and SAS is processing the code locally on your PC.

But what happens when SAS Enterprise Guide is introduced into the mix? For most of you, this means no longer having a 'local' version of SAS. Instead, you will use a 'server' version of SAS. It is the job of SAS Enterprise Guide to take the code you submit and copy it from your PC to the server. This SAS server processes your code and returns all the appropriate results to SAS Enterprise Guide on your PC.

Sometimes, this SAS Server resides in your building. However, the server could be located in a more remote location, such as an office in another state. Also, this SAS Server probably either hosts your data or has direct access to your data. The server does all the ‘number crunching’--that is, processing your code.

As you move to this new environment, this paper discusses the many exciting features of your trip. Think of it as your travel guide. This paper also covers a few of things that might not go as planned. But fear not. Traveling with SAS Enterprise Guide is a good thing.

FEAR OF FLYING

Have you ever flown overseas? Suppose you are on your first inter-continental flight. It could be ten or more hours, high over the ocean, with nowhere to land if something should go wrong. It could be nerve-wracking, fear-inducing. Perhaps, you just do not like traveling away from home or have a fear of flying. It might not surprise you to know that like flying, moving over to SAS Enterprise Guide sometimes results in fear.
The familiar SAS Windowing Environment might no longer be available. Will your code still work? Will your skill set still be valuable? How will you write and submit code in this new environment? All of these questions can be answered and turn this bumpy ride into a smooth trip.

Will your code still work? The simple answer is 'yes.' Here is an example of some code that runs in both environments without any changes.

```sas
data sales;
  input CustID $ Week1 Week10;
  Increase=Week1-Week10;
  datalines;
  3500 150 149
  3501 221 245
  3502 234 150
  3503 175 222
;
run;

proc print data=sales;
run;
```

Figure 3. Example Code that Works in Both Environments without Any Changes

Notice that these two steps do not have any host-specific references, such as filenames, libraries, or catalogs. If the code did contain these references, you might have to make some changes before the code ran correctly in the new environment. (For more information, see “Changing Planes” section.) A good rule of thumb is 90% of SAS code is platform-independent and 10% of the code depends on the host environment.

Will your skill set still be valuable? As it turns out, SAS Enterprise Guide will make you more valuable than ever. SAS Enterprise Guide is a tool that is not taking anything away from you as a programmer. In fact, you will discover the exact opposite. SAS Enterprise Guide gives you more tools than ever to become the best programmer you can be. There are even times you can let SAS Enterprise Guide write code for you! (More information about that in the next section “Readying for Takeoff.”) If you exploit the full functionality of SAS Enterprise Guide (including point-and-click), you can attain an entirely new level of marketable skills.

How will you write and submit code in this new environment? The code in Figure 3 is stored in sales.sas on your hard drive. In your SAS Enterprise Guide project, select File © Open © Program and browse for sales.sas. Select sales.sas and click Open. Or to write a new program from scratch, select File © New © Program and begin entering your code into the Program Editor. When you are ready to submit your code, select Run in the Program Editor or press F3 or F8.

Figure 4. Starting a New Program and Opening an Existing Program

So now that you have decided to step on the plane and take this journey, perhaps a few of your fears have subsided. It is possible you might even be a little excited about some of the other sights and sounds or tips and tricks you will discover in this paper. Settle in and buckle your seatbelts. There are more things to see.

READYING FOR TAKEOFF

As you pass through the airport and head towards your flight, you need proper documentation. In the world of today the very minimum credentials consists of a proper photo identification and a boarding pass. You also pass through a security checkpoint or two. Many of today’s businesses also require documentation compliance on any analysis in addition to the final results. Some regulated industries even require audits. SAS Enterprise Guide has several tools in place to make it easier to comply with these regulations.
It is much easier to meet documentation compliance with SAS Enterprise Guide because of features like the Process Flow window, the Program Analyzer, and Notes. If you work in heavily-regulated industries such as financial services, pharmaceutical, or telecommunications, you may be required to meet certain audit and governance compliance standards with your code. In addition, you might be required to provide a certain level of documentation. Or perhaps you are a consultant that standardizes for various metrics or even needs to set up project control and version control documentation. SAS Enterprise Guide makes it easier to meet these requirements. (For information about source control management see (Hemedinger, Using source control management with SAS Enterprise Guide, 2012).)

- **Process Flow Window**: The Process Flow window displays a ‘process flow diagram’ of your code including any inputs and outputs. Press F4 or select Process Flow in the top toolbar to make the window active. If you were using all the features of SAS Enterprise Guide, the Process Flow window would display the relationship between any objects including tasks. This diagram indicates (just like you read a book from top to bottom and left to right) how the entire project would run if submitted at once. A project is the tool that SAS Enterprise Guide uses to store and collect related data, tasks, code, and results.

![Process Flow Window](image)

*Figure 5. Example of a Process Flow*

- **Program Analyzer**: SAS Enterprise Guide can analyze your code, reveal the individual components, and show how the components are related. This analysis can provide documentation in the form of a process flow diagram. To create this documentation, first select Program → Analyze → Analyze for Program Flow → **Begin analysis**. Then provide a name for your process flow and select Create process flow. You can also analyze a program for grid computing, and starting in SAS Enterprise Guide 6.1, you can analyze your code for internationalization. When you analyze a program for internationalization, it is optimized so that it can be adapted to any language and region without modification.

![Code Analysis in a Process Flow Window](image)

*Figure 6. Example of Code Analysis in a Process Flow Window*
You might not be a point-and-click type of person. Maybe you have never traveled outside your own country... or even your own state or region? Isn’t it time that you tried? Aren’t you a little curious about what SAS Enterprise Guide might have to offer? Isn’t there one long distance destination where you would like to travel to in your lifetime? Here is the amazing thing about SAS Enterprise Guide. Not only can you write your own code and submit it, but you can also let SAS Enterprise Guide write code for you and submit that as well. Here’s a great example.

There is a programmer who uses PROC TABULATE only a couple of times a year. Every time she wants to rotate a data set, she not only forgets the syntax, but also in which direction to flip the table. The TABULATE procedure can be challenging syntax if you do not use it all the time. SAS Enterprise Guide has two easy tasks (Split Columns and Stack Columns) that make rotating data sets very easy. Check out these tasks under the Data category and let SAS Enterprise Guide write the TABULATE code while you point-and-click. Then examine and review the syntax after the task runs successfully. Don’t like to write SAS/GRAPH code? Try the Line Plot Wizard or the Bar Chart Wizard. You will not regret it. These tasks help you overcome syntax challenges or tap into procedures you never or rarely use, thereby boosting your SAS proficiency.

EASING TURBULENCE AHEAD

In many ways, you probably wish your coding life ran like a smooth airplane trip. You might be perfectly happy if you could continue your day-to-day SAS operations without turbulence. When SAS Enterprise Guide is brought into your workplace, you might meet some resistance (similar to turbulence encountered on a plane). “I know what I’m doing, don’t make me learn something new.” “I’m comfortable with the current interface, why should I even consider looking at a new one?” “Why are you taking away something that works?” These are not unusual reactions from seasoned programmers thrust into SAS Enterprise Guide. Here are some reasons to be glad that you decided to take this voyage and ease that turbulence ahead.

The Program Editor in SAS Enterprise Guide has several features that are especially attractive to new programmers. Here are some examples from SAS Enterprise Guide 6.1:

- **Autocompletion – Syntax Suggestion:** As soon as you enter the first two letters of a keyword, a selection list appears with possible SAS keywords (procedure names and options) that complete the spelling. This operates much like other electronic devices’ operating systems, such as those on your mobile phone. To add a suggested keyword to your program, complete one of these steps:
  - Double-click a selected keyword.
  - Select a keyword and press either the spacebar, Enter, or Tab. If you use the spacebar, the autocompletion feature will continue with the next keyword.
  - Select the next valid key, such as the semicolon, period, or equal sign.

![Figure 7. Possible Global Statements Suggested by Autocompletion](image)
• **Autocompletion – Libraries, Data Sets, and Variable Names:** SAS Enterprise Guide can also provide you with selection lists for some libraries, data sets, and variable names in your current session.

![Figure 8. Possible Variables Suggested for VAR Statement in PRINT Procedure](image)

• **Abbreviated Syntax Help:** By positioning the mouse pointer directly over a keyword in the Program Editor, a pop-up window appears with abbreviated syntax help. This window can also contain links to documentation, samples, SAS notes, and related papers. The syntax help can be invoked in one of these ways:
  • Position the mouse pointer over any valid SAS keyword in the Program Editor.
  • Place the cursor within any valid SAS keyword and press F1.
  • Position the mouse pointer over any suggested keyword in a pop-up syntax list in the Program Editor.

![Figure 9. Abbreviated Syntax Help for the LENGTH Keyword](image)

• **Autocompletion – Off:** It is possible that as a seasoned programmer you do not need any syntax help. To customize or turn off these autocompletion features, select **Tools ⇒ Options.** In the Options dialog box, select **SAS Programs ⇒ Editor Options ⇒ Autocomplete.**

![Figure 10. Partial Listing of Available Autocompletion Options](image)

• **Parenthesis Highlighting:** The Program Editor highlights pairs of parentheses, braces, and brackets to prevent you from leaving pairs open-ended. If only one side of the parentheses, braces, or brackets is highlighted, there is a missing match to be resolved.

![Figure 11. Highlighted Matching Pair of Parentheses in SUBSTR() Function](image)
• **Code Formatter:** To make your programs slightly easier to read, document, and debug, use the code formatter. Right-click in the Program Editor window and select **Format Code** (or Ctrl + I) to “clean up” your code and add some consistency, spacing, and indentation.

```
4: data SGP.sales; length Key $2;
5: infile "C:\Users\Andy\SGP2014\RawData\sales.dat";
6: input CustID $ Week1 Week10;
7: Increase=Week1-Week10; Key=substr(CustID,1,2);
8: ;
9: run;
```

**Figure 12. Your Code Before and After Using the Code Formatter**

• **Log Summary Window:** After you submit your program, a skeleton summary of the messages in the log appear in the Log Summary window. This window contains one line per note, warning, or note that was generated during the run. Select the message in the Log Summary window to view the message in the program or log source file. By default, this window appears below the Program and Log windows after the code runs. If the window is closed, select **View  Log Summary** to re-open it.

**Figure 13. Example of the Log Summary Window**

**CHANGING PLANES DURING A LAYOVER**

During those longer trips, changing planes might not go as smoothly as you hope, and sometimes changing planes can require a bit of effort. The previous code in Figure 3 did not require any changes whether it was run on your local machine or the new environment of a remote server. But it is possible that the code might contain some external references that need to be adjusted for the code to run successfully in that new environment. Here are the top things to consider when switching to a server-based environment:

1) **Your SAS Program Has Left The Country:** Suppose you live in the United States. When SAS Enterprise Guide enters the picture, your SAS program is now flown overseas to Paris, France to be processed. Your code is no longer here on your local PC. Do not expect your program to be able to see the local drives or local data on your PC. Remember, your code is no longer in the United States and cannot see the Statue of Liberty! However, if your code wants to visit the Eifel Tower, that is no problem. Any mapped drives or data located on that remote server are now available to your program. Start thinking as if you are writing all your programs so that they are going to be submitted from Paris—the remote server.

2) **Host-Specific References:** Any programming statements that involve host-specific references to external locations will probably need to be updated for the new environment. (It is possible that you are moving from a Windows machine to another Windows machine, and the drives can be re-mapped with the exact same letters.) These references might include (but are not limited to) directory paths in the INFILE, FILE, FILENAME, LIBNAME, and %INCLUDE statements; macros; Output Delivery System; and paths to libraries, catalogs, and
formats. (You might need to remove LIBNAME statements to allow library references in the metadata to take precedence. Check with your SAS Administrator.)

3) **SAS/AF®, SAS/FSP®, and Dynamic Data Exchange (DDE):** There are a couple of popular features that are not supported in SAS Enterprise Guide. They involve interactive windows and Microsoft Excel. Here are the details and suggested workarounds.

   a. **SAS/AF and SAS/FSP:** SAS/FSP, SAS/AF, and the Macro Window are not available in SAS Enterprise Guide. You can replace the functionality of these by using prompts or writing custom tasks. Prompts are easy to learn and create. They are pop-up windows that allow you to enter values at run time in order to get custom reports. You can learn how to use prompts by taking the SAS Enterprise Guide 1 class offered by SAS Institute. Custom tasks are a little more involved to create, but they offer a lot more flexibility in their capability. If you are interested in learning to write custom tasks, see (Hemedinger, Custom Tasks for SAS Enterprise Guide Using Microsoft .NET, 2012).

   b. **DDE:** SAS Enterprise Guide does not reliably support DDE. Dynamic data exchange is a legacy Microsoft methodology that allows applications to communicate with each other. While it might work in certain circumstances, DDE is not explicitly supported when Microsoft Excel is run in a server-based environment (which is common to SAS Enterprise Guide). An optimum solution would be to use the SAS® Add-In for Microsoft Office, if available. See (Hemedinger, How do I export from SAS to Excel files: Let me count the ways, 2012) for all your other combined SAS Enterprise Guide and Excel needs.

4) **UNIX:** If moving from a Windows to a UNIX environment, data sets need to be converted and copied via PROC CIMPORT and PROC PORT. Also keep in mind that the UNIX environment is case sensitive where the Windows environment is not. SAS Enterprise Guide also has some tasks that can help you with copying data sets. Under the **Data** category, you can use either the Upload Data Files to Server or Download Data Files to PC tasks.

![Figure 14. Upload and Download Tasks Available from Data Category](image)

The following code runs without error on SAS for Windows on a local machine. The selected items need to be modified in order for this code to run successfully using SAS Enterprise Guide on a UNIX remote server.

```sas
options font="sas monospace bold" 12 FULLSTIMER;
libname SGF "C:\Users\Andy\SGF2014\DataSets";

data SGF.sales;
  length Key $2;
  infile "C:\Users\Andy\SGF2014\RawData\sales.dat";
  input CustID $ Week1 Week10;
  Increase=Week1-Week10;
  Key=substr(CustID,1,2);
; run;
```
ods csv file="C:\Users\Andy\SGF2014\Reports\sales.csv";
proc print data=SGF.sales;
run;
ods csv close file="C:\Users\Andy\SGF2014\Reports\sales.csv";

Figure 15. Example Code Written for Windows Environment with Host-Specific Lines Highlighted

The FONT= option needs to be removed because it is a host-specific option available only to Windows environments. This option is not recognized on the UNIX operating system.

Your organization might be moving to a more secure setup that includes metadata for libraries. There are many advantages and best practices with this new environment. It is possible that you might have to discuss with your SAS Administrator where your libraries should be stored on the UNIX server. Or perhaps those libraries have already been created for you. In this example, the SAS Administrator is responsible for setting up all libraries (including the metadata) for all groups in your organization. Because the library reference is pre-defined, the LIBNAME statement is deleted from the program.

Sales.dat is a space-delimited, raw data file located in the C:\Users\Andy\SGF2014\RawData folder. On the UNIX server, a new personal directory can be created for your SAS files. In this example, a single subdirectory (/home/SASAndy/sasfiles) is created to hold all SAS files. The sales.dat file should be moved or copied from the local Windows machine to this subdirectory on the UNIX server. One option is to FTP this file between the two machines. (A better option is discussed later.) Modify the INFILE statement to reflect the new location on the UNIX server.

Finally, both ODS statements are modified. The output will be created in the newly created sasfiles subdirectory on the UNIX server instead of the Reports folder on the Windows machine.

options FULLSTIMER;

data SGF.sales;
  length Key $2;
  infile "/home/SASAndy/sasfiles/sales.dat";
  input CustID $ Week1 Week10;
  Increase=Week1 Week10;
  Key=substr(CustID,1,2);
;
run;

ods csv file="/home/SASAndy/sasfiles/sales.csv";
proc print data=SGF.sales;
run;
ods csv close file="/home/SASAndy/sasfiles/sales.csv";

Figure 16. Example Code Updated for UNIX Environment

Now the sales.csv file is located on the UNIX server and NOT on your local Windows machine where you most likely want it. While you could FTP this file between machines, once again your friend Chris Hemedinger has come to the rescue. Chris has written a custom task that enables you to easily bring back just about any type of file (Excel, CSV, PDF, RTF, and more) from the remote machine to your local PC. See these papers for more information: (Hemedinger, There and back again: copying files in SAS Enterprise Guide, 2012) and (Hemedinger, Export and download any file from SAS Enterprise Guide, 2013).

As you attempt to run your code in the new SAS Enterprise Guide environment, you might discover that it requires any number of changes. It is possible that no changes are required or perhaps many are necessary. One exciting thing about having your code process in this new environment is that you can share your SAS genius with others. That's right! Your code is now executing in a central location, so you can share it. You can pass on the brilliance of your SAS coding and reports to others in your department. (In fact if available, you might want to look into creating stored processes. This is the best way to share SAS programs in a sound and secure manner.)
FLIGHT ASSISTANCE

Whenever you travel, you will eventually have a question about something. Maybe you do not speak the language. Or you are looking for a particular street. Or you just need to buy some fresh batteries for your camera. Where can you go for help? There are so many wonderful resources available to you for SAS Enterprise Guide. You need to know what they are, where they are, and how to use them.

- **Chris Hemedinger’s Blog**: A favorite location for help is The SAS Dummy on blogs.sas.com ([http://blogs.sas.com/content/sasdummy/](http://blogs.sas.com/content/sasdummy/)). Chris is a technical architect who has been working with SAS Enterprise Guide for many years and written books on the topic. If you have a specific SAS Enterprise Guide question, odds are good that Chris has answered it on his blog. Search for answers here first.

![Figure 17. The SAS Dummy Blog](image)

- **communities.sas.com**: Help with the SAS Enterprise Guide product is available in the SAS Support Communities. See [https://communities.sas.com/community/support-communities/sas_enterprise_guide](https://communities.sas.com/community/support-communities/sas_enterprise_guide). This community consist of users and experts who post experiences, questions, answers, and ideas about SAS Enterprise Guide. There are also many links to other excellent resources. You can browse this site, but in order to post, you must join the community.

![Figure 18. Website for SAS Enterprise Guide Community](image)
Lex Jansen Search: Lex Jansen is a SAS employee who has created an incredible custom search website. To date, it can search over 25,000 SAS papers from user group conferences. When you visit www.lexjansen.com, enter “Enterprise Guide” as a keyword along with any other topic you desire. By the way, you can use this website to search on any SAS topic. You will be surprised at how many papers have already been written on your topic of interest.

![Image of Lex Jansen Web Site]

Figure 19. Lex Jansen Web Site

SAS Documentation: The help available in the SAS Enterprise Guide software product is excellent. There are two additional documentation resources on support.sas.com that might come in handy. The product documentation page contains assistance for all releases of SAS Enterprise Guide (http://support.sas.com/documentation/onlinedoc/guide/index.html). The software product page for SAS Enterprise Guide has many other important resources, including the latest hot fixes and highlighted samples (http://support.sas.com/software/products/guide/index.html).

![Image of Online Resources for SAS Enterprise Guide]

Figure 20. Online Resources for SAS Enterprise Guide

FAREWELL - ARRIVAL AT YOUR DESTINATION

Your journey in this paper has come to an end, but hopefully your travels with SAS Enterprise Guide are just beginning. If you can take advantage of a few of the tips and resources mentioned in this paper, your excursion into this new coding environment will be a fruitful one. There are new releases of SAS Enterprise Guide just around the corner. If you have questions about SAS Enterprise Guide or if there is a feature you would like to see implemented, please contact SAS Technical Support. Bon Voyage! Your time with Enterprise Guide is well spent and will make you a better programmer.

REFERENCES


This flight would not have been possible without the help and contributions from: Cynthia Johnson, Earl Zaromb and especially Kate Schwarz.

**CONTACT INFORMATION**

Your comments and questions are valued and encouraged. Contact the author:

Andy Ravenna  
787 Seventh Avenue, 47th Floor  
New York, NY 10019  
SAS Institute Inc.  
Andy.Ravenna@sas.com  
http://www.sas.com

SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries. ® indicates USA registration.

Other brand and product names are trademarks of their respective companies.